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KATA PENGANTAR 

 

Buku seri praktikum Riset Operasional 1 ini menjelaskan penerapan teori 

pengambilan keputusan terutama dalam lingkup perusahaan. Demikian juga 

pembahasan dilakukan pada masalah-masalah yang bersifat mendasar atau pokok. 

Tujuan penyusunan modul Riset Operasional 1 untuk menjelaskan masalah 

pengambilan keputusan dalam memilih aktivitas-aktivitas yang mendatangkan 

hasil optimum dengan biaya minimum. Dengan demikian diharapkan dapat 

memberikan pemahaman logika atau alasan yang menjelaskan mengapa 

perusahaan mengambil keputusan tersebut. 

Dalam kesempatan ini, penyusun ingin mengucapkan terima kasih kepada 

kedua orang tua kami, staff Laboratorium Manajemen Menengah Universitas 

Gunadarma, juga para asisten senior dan rekan-rekan asisten lainnya yang telah 

memberikan bantuan dalam penyusunan modul Riset Operasional 1 ini. 

Penulis menyadari bahwa masih banyak kekurangan yang terdapat dalam 

modul ini, oleh karena itu kami memohon kritik dan saran yang bersifat 

konstruktif demi perbaikan dalam penyusunan modul yang akan datang. Semoga 

modul ini dapat memberikan manfaat positif pembacanya. 

Akhir kata semoga seri praktikum ini dapat memberikan manfaat bagi 

pembaca, kritik dan saran sangat kami harapkan demi pengembangan modul ini di 

masa yang akan datang. 

 

Depok, September 2024 

 

 

Penyusun  
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BAB I   

SIMPLEX 
 

Deskripsi Modul  

Linear Programming (LP) adalah suatu cara untuk menyelesaikan persoalan 

pengalokasian sumber-sumber yang terbatas di antara beberapa aktivitas yang 

bersaing dengan cara terbaik yang mungkin dilakukan. Persoalan pengalokasian 

ini akan muncul manakala seseorang harus memilih tingkat aktivitas-aktivitas 

tertentu yang bersaing dalam hal penggunaan sumber daya langka yang 

dibutuhkan untuk melaksanakan aktivitas-aktivitas tertentu. 

Tujuan Modul 

Setelah menyelesaikan praktikum pada modul ini, praktikan akan memahami: 

1) Perencanaan aktivitas untuk memperoleh hasil optimum dengan batasan- 

batasan yang dimiliki; 

2) Keputusan mana yang harus dipilih. 

 

Isi 

Pembelajaran: Linear Programming 

Latihan 1 Menghitung Simplex 

Pembelajaran: Penggunaan Software POM QM 
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Perang Dunia 

II berlangsung 

 

Pembentukan 

kelompok formal 

RO Inggris (1939) 

 

Amerika mengikuti 

dengan US NAVY 

 

RO berkembang hingga ke Statistika Pengendalian Mutu, Pemrograman 

Dinamis, Analisis Queue dan Pengendalian Persediaan, Pemrograman 

Geometris, Simulasi, dan Goal. 

 

1.1 Pembelajaran: Linear Programming 

Riset operasional adalah sekumpulan cara atau metode analisis yang 

digunakan untuk mengelola sumber daya perusahaan yang terbatas agar hasil yang 

optimal didapat perusahaan. 

RO juga dapat digunakan untuk memaksimalkan sesuatu yang diinginkan 

(seperti hasil produksi, penjualan, keuntungan, dll.) dan dapat juga digunakan 

untuk meminimumkan sesuatu yang tidak diinginkan oleh perusahaan (seperti 

kecelakaan kerja, kerugian, produk cacat, dll.)  

1.2  Sejarah Munculnya RO 

 

 

      

 

 

 

 

 

 

 

Oleh G.A Robert dan DR. E.C. 

William dalam usaha 

mengembangkan sistem 

komunikasi 

 

 

Mengembangkan cara 

untuk memenangkan 

perang melawan Jepang 

 

 

Perang Dunia selesai. 

 

RO diterapkan untuk 

memecahkan masalah 

manajerial dan 

operasional. 

 

Metode yang terkenal yaitu Linear 

Programming yang dikenalkan oleh 

George Dantzig (Bapak Linear 

Programming) 
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1.3  Linear Programming 

Linear Programming atau pemrograman linier berasal dari kata 

pemrograman dan linier. Pemrograman mempunyai arti perencanaan, dan linier 

berarti fungsi-fungsi yang digunakan merupakan fungsi linier. 

Secara umum arti dari pemrograman linier adalah suatu teknik perencanaan 

yang bersifat analitis yang analisis-analisisnya memakai model matematika, 

dengan tujuan menemukan beberapa kombinasi alternatif pemecahan masalah, 

kemudian dipilih yang terbaik diantaranya dalam rangka menyusun strategi dan 

langkah-langkah kebijaksanaan lebih lanjut tentang alokasi sumber daya dan dana 

yang terbatas guna mencapai tujuan dan sasaran yang diinginkan secara optimal.  

 Untuk merumuskan suatu masalah ke dalam bentuk pemrograman linier 

harus dipenuhi syarat-syarat berikut : 

1) Tujuan masalah tersebut harus tegas dan jelas; 

2) Harus ada satu atau beberapa alternatif yang ingin dibandingkan; 

3) Adanya sumber daya terbatas; 

4) Bisa dilakukan perumusan kuantitatif; 

5) Adanya keterkaitan peubah. 

Untuk membentuk suatu model pemrograman linier perlu diterapkan asumsi 

sebagai berikut: 

1. Linearity  

Fungsi objektif dan kendala haruslah merupakan fungsi linier dan variabel 

keputusan. Hal ini akan mengakibatkan fungsi bersifat proporsional dan 

aditif, misalnya untuk memproduksi 1 kursi dibutuhkan waktu 3 jam, maka 

untuk memproduksi 2 kursi dibutuhkan waktu 6 jam. 

2. Divisibility  

 Nilai variabel keputusan dapat berupa bilangan pecahan. 

 

3. Nonnegativity  

Nilai variabel keputusan haruslah non negatif. 
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Hanya mempelajari SIMPLEX 

4. Certainty 

Semua konstanta mempunyai nilai yang sudah pasti. 

 

Dua Macam Fungsi Program Linier : 

• Fungsi tujuan      : mengarahkan analisa untuk mendeteksi tujuan 

perumusan masalah.  

• Fungsi kendala : untuk mengetahui sumber daya yang tersedia dan 

permintaan atas sumber daya tersebut. 

 

Metode-metode yang ada di Linear Programming : 

1. Grafik  → Kendala : hanya untuk perusahaan yang memproduksi 2 produk. 

2. Simplex  

3. Dualitas  → Digunakan bila terjadi perubahan kapasitas. 
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1.4 Metode Simplex 

Tahun 1947 diperkenalkan oleh George B. Dantzig merupakan suatu 

algoritma yang digunakan untuk pemecahan berbagai masalah Linear 

Programming (LP). Pemecahan masalah dengan menggunakan metode ini sangat 

menguntungkan bagi pengguna, karena tidak hanya fungsi tujuan dan nilai 

optimum dari variabel dapat kita ketahui, tetapi kita juga dapat memberikan 

interpretasi ekonomi dan melakukan analisis sensitivitas yang didasarkan pada 

proses iterasi. 

Ada 3 ciri utama dari suatu bentuk baku pemrograman linier untuk 

algoritma simplex: 

1) Semua kendala harus berada dalam bentuk persamaan dengan nilai kanan 

tidak negatif. 

2) Semua variabel yang terlibat tidak dapat bernilai negatif. 

3) Dapat berupa maksimisasi dan minimisasi. 

 

Komponen dalam Simplex : 

1) Variabel keputusan (Decision Variable) 

2) Fungsi tujuan (Objective Function) 

 

3) Kendala (Constraints) 
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Contoh Soal 

PT Elfrianda memproduksi tiga jenis keramik untuk dijadikan souvenir, yaitu mug 

keramik, piring keramik, dan vas bunga keramik. Keuntungan yang diharapkan 

dari masing-masing keramik adalah Rp 2.800.000, Rp 2.000.000, dan Rp 

2.400.000. Untuk memproduksi mug keramik dibutuhkan 80 pcs keramik, 40 liter 

pewarna, dan waktu pencetakan selama 40 menit. Untuk piring keramik 

dibutuhkan 60 pcs keramik, 35 liter pewarna, dan waktu pencetakan selama 25 

menit. Sedangkan untuk vas bunga keramik dibutuhkan 70 pcs keramik, 60 liter 

pewarna, dan waktu pencetakan selama 90 menit. PT Elfrianda mempunyai 

kapasitas maksimum untuk keramik adalah 2.800 pcs, pewarna 1.600 liter, dan 

waktu pencetakan selama 2.400 menit. Tentukanlah keuntungan yang diperoleh 

perusahaan! 

 

Langkah Penyelesaian : 

Step 1 : Identifikasikan variabel keputusan, fungsi tujuan, dan variabel 

kendala 

Variabel Keputusan  

X1 =  Mug Keramik  

X2 =  Piring Keramik 

X3 =  Vas Bunga Keramik 

Step 2 : Tentukan fungsi tujuan, apakah akan di maksimalisasi atau 

minimalisasi 

Maksimumkan Z = 2.800.000X1 + 2.000.000X2 + 2.400.000X3   

 

 

 



 
11 Riset Operasional 1 

 

Step 3 : Formulasikan faktor kendala yang ada dalam bentuk : 

➢  Perwujudan informasi paling sedikit atau minimum 

➢  Perwujudan informasi paling banyak atau maksimum 

➢  Perwujudan informasi paling memadai 

 

➔ Kendalanya : keramik, pewarna, dan waktu pencetakan. 

➔ Diurutkan sesuai jenis kendalanya, menjadi seperti di bawah ini. 

➔ Karena perwujudan informasi paling banyak atau maksimum pada soal di 

atas maka kita pakai simbol  

Fungsi Kendala 

1. Keramik   80X1 + 60X2 + 70X3 ≤ 2.800  

2. Pewarna   40X1 + 35X2 + 60X3 ≤ 1.600 

3. Pencetakan   40X1 + 25X2 + 90X3 ≤ 2.400 

 di mana  X1, X2, X3 ≥ 0 

 

Step 4 : Ubahlah fungsi tujuan dan variabel kendala menjadi fungsi impulsif 

dengan cara menggeser semua CnXn ke kiri 

 Formulasikan faktor kendala yang ada dalam bentuk : 

o fungsi kendala memakai simbol  maka harus ditambah S 

o fungsi kendala memakai simbol > maka harus ditambah  S A 

o fungsi kendala memakai simbol = maka harus ditambah A 

note : S = slack 

 

 

 

Di sini kita hanya mempelajari fungsi kendala memakai 

simbol  
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Fungsi Tujuan 

Maksimumkan Z – 2.800.000X1 – 2.000.000X2 – 2.400.000X3 = 0 

Fungsi Kendala 

1. Keramik   80X1 + 60X2 + 70X3 + S1 = 2.800 

2. Pewarna   40X1 + 35X2 + 60X3 + S2 = 1.600 

3. Pencetakan   40X1 + 25X2 + 90X3 + S3 = 2.400   

 dimana  X1, X2, X3  0 

Step 5 : Susunlah persamaan yang diperoleh ke dalam tabel iterasi 

Step 6 : Tentukanlah kolom kunci 

Kolom kunci ditentukan berdasarkan nilai yang paling besar negatifnya dari nilai-

nilai yang berada pada baris fungsi tujuan (Z) pada tabel simpleks. 

Step 7 : Tentukanlah baris kunci 

Baris kunci ditentukan dengan membuat nilai perbandingan antara nilai kanan 

(NK) dengan nilai pada kolom kunci dari setiap baris, kecuali baris fungsi tujuan. 

Baris dengan perbandingan yang terkecil akan berperan sebagai baris kunci. 

Pertemuan antara kolom kunci dan baris kunci dinamakan angka kunci.   

 

 

 

 

 

VD X1 X2 X3 S1 S2 S3 NK Index 

Z -2.800.000 -2.000.000 -2.400.000 0 0 0 0 - 

S1 80 60 70 1 0 0 2800 35 

S2 40 35 60 0 1 0 1600 40 

S3 40 25 90 0 0 1 2400 60 
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- 

Step 8 : Tentukan persamaan baru/ baris kunci (NBBK) 

S1 → X1 

       NBBK X1 X2 X3 S1            S2     S3 NK 
 

                         

       

                                                          

  

Step 9 : Tentukan persamaan-persamaan baru selain NBBK 

Z -2.800.000      -2.000.000      -2.400.000  0                             0      

(-2.800.000)  (                                            35)    

            (-2.800.000    -2.100.000      -2.450.000   -35.000                -98.000. 000)   

          0       100.000          50.000       35.000     0                98.000.000 

 

S2       40         35                 60             0                1.600      

        (40)       (                                                                     35)   

        (40         30       35              0,5                         1.400) - 

          0         5       25             -0,5                       200 
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S3      40              25                 90             0                             2.400      

        (40)      (                                                                     35)        

       (40                    30       35             0,5                             1.400) - 

         0         -5       55            -0,5          0                     1.000 

 

Step 10 : Masukkanlah nilai-nilai baru ke dalam tabel iterasi 1 

VD X1 X2 X3 S1 S2 S3     NK 

Z 0 100.000 50.000 35.000 0 0 98.000.000 

S2 0 5 25 -0.5 1 0        200 

S3 0 -5 55 -0.5 0 1        1000 

X1 1 ¾   0 0    35 

 

Step 11: Karena nilai di baris Z sudah tidak ada lagi nilai (-) jadi tidak perlu 

diterasi  lagi. Bila masih terdapat nilai negatif pada baris Z, maka 

langkah selanjutnya ulangi langkah mulai Step 5, menentukan 

Kolom Kunci, Baris Kunci, NBBK. 

 

Analisis: 

Keuntungan yang akan diperoleh PT. Elfrianda keramik adalah Rp 98.000.000 

dengan memproduksi 35 mug keramik tanpa memproduksi piring keramik dan vas 

bunga keramik. 
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Langkah-langkah pengerjaan menggunakan software POM-QM 

1. Start → Search Program → POM-QM. Kemudian klik. 

 

 

 

2. Di menu bar Module → Linear Programming. Lalu, klik. 
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3. Pilih menu File → Klik New 

 

 

 

4. Input jumlah baris (constraints) dan kolom (variables) sesuai dengan soal. 
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5. Input data sesuai dengan soal.  

 

    

 

6. Klik Solve 

 

 

 

7. Hasil perhitungan aplikasi, keuntungan yang akan diperoleh PT. Elfrianda 

keramik adalah Rp 98.000.000 dengan memproduksi 35 mug keramik tanpa 

memproduksi piring keramik dan vas bunga keramik. 
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Soal-Soal  Uji Kemampuan 

1. Sofia ingin memproduksi berbagai macam kue kering yaitu kastengel, 

nastar, dan putri salju. Untuk memproduksi kastengel diperlukan 200 g 

tepung terigu, 50g gula, dan 4 butir telur. Untuk nastar diperlukan 300g 

tepung terigu, 60g gula, dan 5 butir telur. Untuk putri salju diperlukan 100 g 

tepung terigu, 40g gula, dan 2 butir telur. Kapasitas maksimum untuk 

tepung terigu adalah 1.600g, untuk gula adalah 500g, dan untuk telur adalah 

60 butir. Keuntungan yang diharapkan masing-masing sebesar Rp. 4.000, 

Rp. 3.000, dan Rp. 2.000. Keuntungan optimal yang akan diperoleh Sofia 

adalah sebesar? 

2. Pak Henry ingin memproduksi tiga jenis tanaman yaitu jagung, kentang dan 

wortel. Untuk memproduksi jagung dibutuhkan 10 unit tanah, 20 liter air, 

dan 60 jam kerja. Untuk kentang dibutuhkan 30 unit tanah, 40 liter air, dan 

90 jam kerja. Untuk wortel diperlukan 40 unit tanah, 30  liter air, dan 50 jam 

kerja. Kapasitas maksimum untuk tanah adalah 800 unit, untuk air adalah 

1.000 liter, dan untuk jam kerja adalah 2.400 jam. Keuntungan yang 

diharapkan masing-masing sebesar Rp. 100.000, Rp. 800.000, dan Rp. 

600.000. Berapa keuntungan maksimal yang dapat diperoleh Pak Henry? 

3. Simon ingin membuat tiga jenis lukisan yaitu lukisan minyak, lukisan 

akrilik dan lukisan cat air. Untuk memproduksi setiap jenis lukisan, 

dibutuhkan kain kanvas, cat, dan jam kerja. Untuk membuat lukisan 

minyak, dibutuhkan 10 unit kain kanvas, 14 liter cat, dan 5 jam kerja. Untuk 

membuat lukisan akrilik, dibutuhkan 20 unit kain kanvas, 25 liter cat, dan 8 

jam kerja. Untuk membuat lukisan cat air, dibutuhkan 15 unit kain kanvas, 

20 liter cat, dan 6 jam kerja. Kapasitas maksimum untuk kain kanvas adalah 

300 unit, untuk cat adalah 450 liter, dan untuk jam kerja adalah 120 jam. 

Keuntungan yang diharapkan masing-masing sebesar Rp. 1.000.000, Rp. 

800.000, dan Rp. 500.000. Berapa keuntungan maksimal yang dapat 

diperoleh Simon? 



 
19 Riset Operasional 1 
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BAB II 

TRANSPORTASI SOLUSI AWAL  
 

Deskripsi Modul 

Metode transportasi merupakan metode yang digunakan untuk mengatur 

distribusi dari sumber yang menyediakan produk ke tempat tujuan yang 

membutuhkan secara optimal. Alokasi produk ini harus diatur, karena terdapat 

perbedaan biaya-biaya alokasi dari satu sumber ke tempat-tempat tujuan. 

Tujuan manajemen adalah menentukan jumlah yang harus dikirimkan 

dengan biaya yang seminimum mungkin. Atau dengan kata lain, mengoptimalkan 

distribusi sumber daya sehingga biaya yang dikeluarkan minimal. 

 

Tujuan Modul 

Setelah menyelesaikan praktikum pada modul ini, praktikan akan memahami: 

1) Bagaimana cara mengatur distribusi dari sumber yang menyediakan produk 

yang sama ke tempat yang membutuhkan secara optimal 

2) Bagaimana meminimalkan biaya untuk memperoleh hasil optimal 

3) Apa saja hakikat dari suatu pengambilan keputusan 

4) Tahapan apa saja yang harus dilalui dalam mengambil suatu keputusan agar 

dapat memberikan hasil yang efektif dan efisien.  
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Isi  

Pembelajaran: North West Corner 

Latihan 1 Menghitung North West Corner 

Pembelajaran: Least Cost 

Latihan 2 Menghitung Least Cost 

Pembelajaran: VAM (Vogel Approximation Method)  

Latihan 3 Menghitung VAM 

Pembelajaran: RAM (Russel Approximation Method)  

Latihan 2 Menghitung RAM 

Pembelajaran: Penggunaan Software Win QSB 
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2.1 Metode Transportasi 

Metode transportasi untuk pertama kali dikemukakan oleh F.L Hitchcock 

(1941) dan dijelaskan lebih mendetail oleh T.C Koopmans (1949). 

 

2.2 Masalah Transportasi 

Masalah transportasi secara umum berhubungan dengan masalah 

pendistribusian barang dari beberapa kelompok tempat penyediaan yang disebut 

SUMBER ke beberapa kelompok tempat penerimaan yang disebut TUJUAN 

dalam masalah tertentu yang dapat meminimumkan total biaya distribusi. Secara 

umum, penyelesaian masalah transportasi dilakukan dengan dua tahap, yakni: 

1) Tahap SOLUSI AWAL 

1. Metode NWC (North West Corner) 

Pengalokasian dimulai dari pojok kiri atas dan berakhir di pojok kanan 

bawah. 

2. Metode LC (Least Cost) 

Pengalokasian dimulai dari biaya terendah dalam tabel  

3. Metode VAM (Vogel Approximation Method) 

Pengalokasian dilakukan pada kotak variabel dengan biaya terendah pada 

baris atau kolom yang terpilih 

4. Metode RAM (Russel Approximation Method) 

Pengalokasian dilakukan dengan nilai  negatif terbesar  

2) Tahap SOLUSI AKHIR  

1. Stepping Stone 

2. MODI (Modified Distribution), merupakan modifikasi dari metode 

Stepping Stone. Namun demikian, solusi akhir akan digunakan bila dalam 

solusi awal penyelesaian biayanya belum optimal. 
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Catatan Penting! 

1. Syarat sel terisi ➔ (M+N)-1, dimana M adalah jumlah baris, N adalah     

jumlah kolom. 

2. Bila (M+N)-1 TIDAK SAMA DENGAN sel terisi, maka harus  

ditambahkan 0 (nol). 

3. Jumlah KAPASITAS harus sama dengan jumlah KEBUTUHAN, jika 

tidak maka perlu ditambahkan DUMMY. 

 

2.3 Transportasi Solusi Awal  

Contoh soal  

PT. KAI memiliki 3 pilihan kereta untuk membantu masyarakat yang ingin mudik 

pada saat lebaran. Tiga pilihan kereta itu adalah kereta Matarmaja, Majapahit, dan 

Malabar, dengan tujuan Malang ke Jakarta melalui Semarang. Kapasitas masing-

masing kereta tersebut adalah 290, 380, dan 230 dengan kebutuhan atau 

permintaan tiket sebesar 125, 415, dan 360. Berikut adalah biaya transportasinya 

per unit. 

 

 

 

 

 

Sumber 
Tujuan 

Malang Semarang Jakarta 

Matarmaja 4 2 7 

Majapahit 1 8 6 

Malabar 5 3 9 
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HAL PERTAMA YANG HARUS DIPERHATIKAN!!! 

Antara kapasitas dengan kebutuhan jumlahnya sama. Untuk kasus ini kita 

namakan kasus normal (tanpa Dummy). Jika antara kapasitas dengan 

kebutuhan jumlahnya tidak sama, maka kasus ini kita namakan kasus tidak 

normal (pakai Dummy). 

Tentukan biaya transportasi dengan metode NWC, LC, VAM dan RAM! 

 

Metode NWC (NORTH WEST CORNER) 

1. Alokasikan komoditi dimulai dari pojok kiri atas dan berakhir di pojok 

kanan bawah. Alokasikan komoditi sesuai dengan kebutuhan/permintaan 

dan kapasitas yang tersedia.  

2. Setelah alokasi untuk C11 dilakukan, alokasi dilakukan pada baris atau 

kolom lain. 

 

 

 

 

 

 

 

 

 

 

 

 

Sumber 
Tujuan 

Kapasitas 
Malang Semarang Jakarta 

Matarmaja 125 4 165 2  7 290 

Majapahit  1 250 8 130 6 380 

Malabar  5  3 230 9 230 

Kebutuhan 125 415 360 900 
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Keterangan : 

1. Alokasi C11 dengan memperhatikan jumlah kapasitas dan kebutuhan (125 

; 290). Minimum 125, maka untuk C11 dialokasikan sebanyak 125. 

2. Ketika 125 produk dialokasikan pada C11, ternyata kebutuhan pada baris 

pertama sebanyak 290 belum terpenuhi, dan kebutuhan pada (kolom 

pertama) sudah terpenuhi, sehingga terjadi kelebihan jumlah kapasitas 

pada sumber pertama, maka akan dialokasikan sebanyak 165 untuk C12. 

3. Ketentuan tersebut dilakukan sampai semua persediaan telah dialokasikan 

dan semua kebutuhan telah terpenuhi. 

 

Total biaya = Jumlah (biaya dikalikan dengan alokasi) 

  =  (125x4) + (165x2) + (250x8) + (130x6) + (230x9) 

  = 5.680  

Analisis : 

 

Dari hasil perhitungan dengan menggunakan metode NWC, Matarmaja 

didistribusikan ke Malang sebanyak 125 dan ke Semarang sebanyak 165. 

Majapahit didistribusikan ke Semarang dan Jakarta masing-masing 250 dan 130. 

Sedangkan Malabar didistribusikan ke Jakarta sebanyak 230. Total biaya 

transportasi yang dikeluarkan PT. KAI adalah sebesar 5.680. 
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HAL YANG HARUS DIPERHATIKAN DALAM 

MENGERJAKAN LC!!! 

Bila dalam kasus tidak normal (dengan Dummy), pengalokasian DUMMY 

selalu TERAKHIR setelah sel lain terisi. Hal tersebut dikarenakan dalam 

LC, perusahaan dianggap lebih memilih untuk mengalokasikan ke tempat 

yang membutuhkan daripada disimpan di dalam gudang. 

Metode LC (LEAST COST) / BIAYA MINIMUM 

1. Alokasikan ke sel yang mempunyai biaya terkecil. Jika terdapat sel yang 

memiliki biaya terkecil yang sama besar, maka pilih salah satu. 

2. Kurangi dengan baris persediaan dan kolom permintaan, jika sudah nol, maka 

eliminasi baris atau kolom tersebut. 

 

 

Penyelesaian: 

1. Pada contoh soal, biaya terkecil terletak pada C21, sehingga sel ini adalah 

yang diprioritaskan terlebih dahulu, dengan kebutuhan dan kapasitas (125 ; 

380) = dengan minimum 125. Kemudian sisa kebutuhannya dialokasikan ke 

sel lain. 

2. Kemudian biaya terkecil kedua terletak pada C12, sehingga sel ini adalah 

yang diprioritaskan kedua, dengan kebutuhan dan kapasitas (415 ; 290) = 

dengan minimum 290. Kemudian sisa kapasitasnya dialokasikan ke sel lain 

3. Kemudian berlanjut ke biaya terkecil berikutnya, yaitu C32, dst. 

Sumber 
Tujuan 

Kapasitas 
Malang Semarang Jakarta 

Matarmaja X 4 290 2 X 7 290 

Majapahit 125 1 X 8 255 6 380 

Malabar X 5 125 3 105 9 230 

Kebutuhan 125 415 360 900 
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4. Alokasi dihentikan jika jumlah persediaan telah dihabiskan dan jumlah 

permintaan telah terpenuhi. 

Total Biaya  = Jumlah (biaya dikalikan dengan alokasi) 

= (290x2) + (125x1) + (255x6) + (125x3) + (105x9) 

 = 3.555 

Analisis : 

Dari hasil perhitungan dengan menggunakan metode LC, Matarmaja 

didistribusikan ke Semarang sebesar 290. Majapahit didistribusikan ke Malang 

dan Jakarta masing-masing sebesar 125 dan 255. Malabar didistribusikan ke 

Semarang dan Jakarta masing-masing sebesar 125 dan 105. Total biaya 

transportasi yang dikeluarkan PT. KAI adalah sebesar 3.555. 

 

Metode VAM (VOGEL APPROXIMATION METHOD) 

1. Menghitung selisih biaya terkecil dengan biaya terkecil berikutnya untuk 

setiap baris dan kolom. 

2. Setelah memperoleh nilai selisih untuk tiap kolom dan baris, pilih biaya yang 

selisih terbesar yang ada pada baris dan kolom tersebut. Kemudian alokasikan 

sebanyak mungkin ke sel yang memiliki biaya terkecil pada baris atau kolom 

terpilih. 

3. Buat tabel pengalokasian untuk barang dari sumber ke tujuan, dengan 

memperhatikan jumlah kapasitas yang tersedia pada kolom atau baris yang 

bersangkutan dengan jumlah permintaan yang harus dipenuhi atau belum 

dipenuhi pada baris atau kolom tersebut. Hapuslah baris dan kolom apabila 

persediaan sudah dialokasikan atau permintaan yang sudah terpenuhi. Ulangi 

langkah pertama, jika jumlah persediaan belum dialokasikan sepenuhnya, 

maka masih terdapat kekurangan persediaan. 
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HAL YANG HARUS DIPERHATIKAN DALAM MENGERJAKAN 

VAM!!! 

Bila dalam kasus tidak normal (dengan Dummy), pengalokasian DUMMY 

diperhitungkan. Karena metode VAM memperhitungkan biaya dummy 

ketika mencari selisih biaya terkecil 

 

Tabel 1 

Sumber 
Tujuan 

Kapasitas Selisih 
Malang Semarang Jakarta 

Matarmaja X 4  2  7 290 4-2=2 

Majapahit 125 1  8  6 380 6-1=5 

Malabar X 5  3  9 230 5-3=2 

Kebutuhan 125 415 360 900  

Selisih 4-1=3 3-2=1 7-6=1   

 

Tabel 2 

Sumber 
Tujuan 

Kapasitas Selisih 
Malang Semarang Jakarta 

Matarmaja X 4  2  7 290 7-2=5 

Majapahit 125 1  8  6 380 8-6=2 

Malabar X 5 230 3 X 9 230 9-3=6 

Kebutuhan 125 415 360 900  

Selisih - 3-2=1 7-6=1   
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Tabel 3 

Sumber 
Tujuan 

Kapasitas Selisih 
Malang Semarang Jakarta 

Matarmaja X 4 185 2 105 7 290 7-2=5 

Majapahit 125 1 X 8 255 6 380 8-6=2 

Malabar X 5 230 3 X 9 230 - 

Kebutuhan 125 415 360 900  

Selisih - 8-2=6 7-6=1   

 

Total Biaya = (185x2) + (105x7) + (125x1) + (255x6) + (230x3) = 3.450 

 

Analisis : 

Dari hasil perhitungan dengan menggunakan metode VAM, Matarmaja 

didistribusikan ke Semarang dan Jakarta masing-masing 185 dan 105. Majapahit 

didistribusikan ke Malang dan Jakarta sebesar 125 dan 255. Sedangkan Malabar 

didistribusikan ke Semarang sebesar 230. Total biaya transportasi yang 

dikeluarkan PT. KAI adalah sebesar 3.450 

  

Metode RAM (RUSSEL APPROXIMATION METHOD) 

1. Penyelesaian dimulai dengan mencari biaya yang tertinggi untuk setiap baris 

dan kolom yang ada dalam tabel transportasinya. 

2. Selanjutnya biaya pada setiap sel akan dikurangi dengan biaya tertinggi untuk 

baris itu dan dikurangi lagi dengan biaya tertinggi kolom itu. 

3. Alokasi diberikan kepada sel yang memiliki nilai negatif terbesar dari 

perhitungan langkah dua. Alokasi selanjutnya dilakukan kembali seperti pada 

langkah pertama dan kedua, di mana baris/kolom yang telah habis 

kapasitas/kebutuhannya tidak diikutsertakan. 
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Tabel awal 

Sumber 
Tujuan 

Kapasitas 
Malang Semarang Jakarta 

Matarmaja  4  2  7 290 

Majapahit  1  8  6 380 

Malabar  5  3  9 230 

Kebutuhan 125 415 360 900 

 

Biaya tertinggi : 

Baris 1 (B1) = 7 Kolom 1 (K1) = 5 

Baris 2 (B2) = 8 Kolom 2 (K2) = 8 

Baris 3 (B3) = 9 Kolom 3 (K3) = 9 

 

 

C11 = 4-7-5 = -8  C21 = 1-8-5 = -12  C31 = 5-9-5 = -9 

C12 = 2-7-8 = -13  C22 = 8-8-8 = -8  C32 = 3-9-8 = -14 → (-) terbesar 

C13 = 7-7-9 = -9  C23 = 6-8-9 = =11  C33 = 9-9-9 = -9  

Tabel 1 

Sumber 
Tujuan 

Kapasitas 
Malang Semarang Jakarta 

Matarmaja  4  2  7 290 

Majapahit  1  8  6 380 

Malabar X 5 230 3 X 9 230 

Kebutuhan 125 415 360 900 

 

 

SEL = biaya sel  biaya tertinggi untuk baris itu  biaya tertinggi kolom itu 
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mengalami perubahan karena baris 3 sudah tidak 

diperhitungkan lagi 

 

PERHATIKAN!!! 

Baris 3, kapasitas yang dimiliki PT. KAI sudah habis, itu artinya biaya-biaya pada 

baris 3 tidak ikut lagi dalam perhitungan langkah 1 dan 2, maka biaya tertinggi : 

B1  = 7  K2 = 8 

B2  = 8  K3 = 7 → mengalami perubahan 

  K1 = 4 → 

 

 

C11  = 4-7-4 = -7   →  mengalami perubahan C21 = 1-8-4 = -11 

C12  = 2-7-8 = -13 → (-) terbesar   C22 = 8-8-8 = -8 

C13  = 7-7-7 = -7      C23 = 6-8-7 = -9 

 

Tabel 2 

Sumber 
Tujuan 

Kapasitas 
Malang Semarang Jakarta 

Matarmaja  4 185 2  7 290 

Majapahit  1 X 8  6 380 

Malabar X 5 230 3 X 9 230 

Kebutuhan 125 415 360 900 

 

PERHATIKAN!!! 

Kolom 2, kebutuhan yang diperlukan sudah terpenuhi, itu artinya biaya-biaya 

pada kolom 2 tidak ikut lagi dalam perhitungan langkah 1 dan 2, maka biaya 

tertinggi: 

B1 = 7       K1 = 4 

B2 = 6  →     K3 = 7  

               

SEL = biaya sel  biaya tertinggi untuk baris itu  biaya tertinggi kolom itu 

mengalami perubahan karena 

kolom 2 tidak diperhitungkan 
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C11  = 4-7-4 = -7 

C13  = 7-7-7 = -7 

C21  = 1-6-4 = -9  → pilih negatif terbesar lalu alokasikan ke C21 

C23  = 6-6-7 = -7 

 

Tabel 3 

Sumber 
Tujuan 

Kapasitas 
Malang Semarang Jakarta 

Matarmaja X 4 185 2  7 290 

Majapahit 125 1 X 8  6 380 

Malabar X 5 230 3 X 9 230 

Kebutuhan 125 415 360 900 

Sisanya bisa langsung dialokasikan dengan memperhatikan biaya terkecil. 

Tabel 4 

Sumber 
Tujuan 

Kapasitas 
Malang Semarang Jakarta 

Matarmaja X 4 185 2 105 7 290 

Majapahit 125 1 X 8  6 380 

Malabar X 5 230 3 X 9 230 

Kebutuhan 125 415 360 900 

Tabel 5 

Sumber 
Tujuan 

Kapasitas 
Malang Semarang Jakarta 

Matarmaja X 4 185 2 105 7 290 

Majapahit 125 1 X 8 255 6 380 

Malabar X 5 230 3 X 9 230 

Kebutuhan 125 415 360 900 

SEL = biaya sel  biaya tertinggi untuk baris itu  biaya tertinggi kolom itu 



 
32 Riset Operasional 1 

 

Total Biaya = (185x2) + (105x7) + (125x1) + (255x6) + (230x3) = 3.450 

 

Analisis: 

Dari hasil perhitungan dengan menggunakan metode RAM, Matarmaja 

didistribusikan ke Semarang dan Jakarta masing-masing 185 dan 105. Majapahit 

didistribusikan ke Malang dan Jakarta sebesar 125 dan 255. Sedangkan Malabar 

mendistribusikan ke Semarang sebesar 230. Total biaya transportasi yang 

dikeluarkan PT. KAI adalah sebesar 3.450. 

 

Langkah-langkah pengerjaan menggunakan software WinQSB 

1. Start  All Program  WinQSB, Buka Program Network Modeling 

 

2. Untuk memulai pilih menu File   New Problem 
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3. Pada form NET Problem Specification pilih : 

• Problem Type = Transportation Problem 

• Objective Criterion = Minimization 

• Problem Title (isi data anda) 

• Number of Sources = 3 

• Number of Destinations = 3 

               

 

 

 

 

 

4. Ubah node names dari menu Edit → Node Names. Edit Node Names, klik 

OK untuk melanjutkan 

   

 

5. Input sesuai dengan soal 
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6. Pilih menu Solve and Analyze > Select Initial Solution Method 

           

 

7. Pilih Northwest Corner Method (NWC), Klik OK untuk melanjutkan 

 

 

8. Pilih menu Solve and Analyze > Select and Display Steps – Tableau untuk 

melihat hasil akhir 
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9. Hasil akhir menggunakan metode NWC 

 

 

10. Untuk menghitung dengan menggunakan metode Vogel’s Approximation 

Method (VAM), pilih menu Solve and Analyze Select Initial Solution 

Method 

 

 

11. Pilih Vogel’s Approximation Method (VAM), klik OK untuk melanjutkan 
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12. Untuk melihat hasil akhirnya pilih menu Solve and Analyze Select and 

Display Steps-Tabelau 

 

13. Hasil akhir menggunakan metode VAM 

 

 

14. Untuk menghitung dengan menggunakan metode Russell’s Approximation 

Method (RAM), pilih menu Solve and Analyze → Select Initial Solution 

Method 
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15. Pilih Russell’s Approximation Method (RAM), klik OK untuk melanjutkan 

 

16. Untuk melihat hasil akhirnya pilih menu Solve and Analyze → Select and 

Display Steps – Tableau 

 

17. Hasil akhir dari metode RAM. 
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Soal-Soal  Uji Kemampuan 

1. PT. ELLA memiliki 3 jenis produk kosmetik yang siap untuk didistribusikan 

ke beberapa kota yang ada di Jawa Barat seperti Bogor, Depok, dan 

Bandung. Kapasitas dari masing-masing kota tersebut adalah 210, 180, dan 

360 dengan kebutuhannya masing-masing 190, 260, dan 300. Berikut adalah 

data transportasinya. Tentukan biaya transportasi dengan menggunakan 

metode NWC, LC, dan RAM! 

Sumber 
 Tujuan  

Bogor Depok Bandung 

Lipstick 3 4 8 

Foundation 4 6 5 

Mascara 2 5 7 

 

2. Anton adalah seorang pengusaha yang bergerak di bidang frozen food. Ia 

memiliki 3 pabrik yang menghasilkan produk yang berbeda yaitu Nugget, 

Sosis, dan Bakso. Suatu hari, masing-masing pabriknya menerima pesanan 

untuk dikirimkan ke Jakarta, Depok, dan Bandung dengan menggunakan 

truk dari setiap masing-masing pabriknya. Dengan kapasitas masing-masing 

90, 70, dan 50. Serta kebutuhan masing-masing 60, 110, dan 40. Berikut 

adalah data transportasinya. Tentukan biaya dan transportasi dengan 

menggunakan metode VAM, LC, dan RAM ! 

Sumber 
 Tujuan  

Jakarta Depok Bandung 

Nugget 6 8 10 

Sosis 25 20 18 

Bakso 10 12 8 
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3. Toko Brownies Felix memiliki 3 pilihan rasa bagi brownies buatannya. Tiga 

pilihan rasa itu Tiramisu, Almond, dan Pandan dengan tujuan Cikaret, 

Sukahati, dan Cibinong. Dengan kapasitas masing-masing yaitu 90, 80, dan 

40. Serta kebutuhannya masing-masing 50, 80, dan 80. Berikut adalah 

transportasinya. Tentukanlah biaya optimalnya dengan menggunakan 

metode NWC, LC, dan VAM! 

 

Sumber 
 Tujuan  

Cikaret Sukahati Cibinong 

Tiramisu 10 4 11 

Almond 9 15 4 

Pandan 30 15 10 
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BAB III 

TRANSPORTASI SOLUSI AKHIR 
 

Deskripsi Modul 

Persoalan transportasi membahas tentang pendistribusian produk dari 

sumber (supply, capacities) kepada tujuan (destination, demand) untuk 

meminimumkan biaya pengangkutan produk tersebut. 

Transportasi solusi akhir merupakan tahap lebih lanjut dari transportasi 

solusi awal. Tujuan menggunakan transportasi solusi akhir yaitu ingin 

memastikan apakah pengalokasian yang dilakukan telah menghasilkan biaya total 

yang sudah paling minimal atau belum. 

 

Tujuan Modul 

Setelah menyelesaikan praktikum pada modul ini, praktikan akan memahami: 

1. Pengalokasian produk ke sejumlah tujuan (destination) 

2. Mengalokasikan dengan biaya total yang seminimal mungkin 

 

Isi 

Pembelajaran: Stepping Stone 

Latihan 1 Menghitung Pengalokasian dengan Metode Stepping Stone 

Pembelajaran: MODI 

Latihan 2 Menghitung Pengalokasian dengan Metode MODI 

Pembelajaran: Software Win QSB untuk metode Stepping Stone dan MODI 
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3.1 Pembelajaran: Stepping Stone 

Metode Stepping Stone digunakan sebagai pengecekan apakah 

perhitungan yang telah kita hitung menggunakan solusi transportasi awal sudah 

benar optimal atau belum. 

Contoh soal  

PT. Dream memiliki 3 cabang pabrik dalam memenuhi permintaan produksinya. 

Dengan kapasitas masing-masing: 

Pabrik Kapasitas produksi 

Hope 250 

Believe 500 

Imagine 750 

Jumlah 1500 

 

Saat ini ada 3 perusahaan yang meminta PT. Dream untuk memenuhi 

kebutuhannya, dengan besaran permintaan masing-masing: 

Perusahaan Kebutuhan 

PT. Sun 300 

PT. Moon 650 

PT. Star 550 

Jumlah 1500 

 

Perkiraan biaya transportasi: 

Perusahaan 

Pabrik 
PT. Sun PT. Moon PT. Star 

Hope 12 42 23 

Believe 21 45 44 

Imagine 15 49 12 
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Hasil Perhitungan dengan Metode VAM: 
 

Tujuan 

Sumber 
PT. Sun PT. Moon PT. Star KAPASITAS 

Pabrik Hope - 12 250 42 - 23 250 

Pabrik Believe 300 21 200 45 - 44 500 

Pabrik Imagine - 15 200 49 550 12 750 

KEBUTUHAN 300 650 550 1500 

 

Total biaya = (250x42) + (300 x 21) + (200 x 27) + (200 x 49) + (550 x 8)  

                     = 42.200 

 

Dari hasil tersebut, kita akan memastikan biaya tersebut sudah paling 

minimal atau belum dengan menggunakan transportasi solusi akhir. 

 

A. Metode STEPPING STONE 

Langkah penyelesaian: 

1. Lakukan pengecekan terhadap sel-sel yang masih kosong. Dari tabel VAM 

di atas, sel yang masih kosong adalah C11, C13, C23, dan C31. Pada metode 

ini, pengujian dilakukan mulai dari sel kosong tersebut, selanjutnya lakukan 

penarikan garis, garis bergerak (searah jarum jam/berlawanan) secara lurus ke 

arah sel yang telah terisi dengan alokasi, tidak boleh diagonal!!! Begitu 

seterusnya sampai kembali ke sel kosong tersebut. Setiap pergerakan ini akan 

mengurangi dan menambah secara bergantian biaya pada sel kosong tersebut. 
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PERHATIKAN! 

Untuk pengujian sel C11 dengan biaya 12, bergerak ke sel C12 sehingga biaya 

dikurangi 42, kemudian bergerak ke sel C22 sehingga biaya ditambah 45, dan 

kemudian bergerak ke sel C21, sehingga biaya dikurangi 21, dan hasilnya adalah 

12 – 42 + 45 – 21 = -6 

 

Untuk pengujian sel kosong lainnya, diberlakukan cara yang serupa. Berikut 

pengujian terhadap sel kosong. 

PENGUJIAN SEL KOSONG 

 

 

 

 

PERHATIKAN! 

Bila dihasilkan angka negatif lebih dari satu sel (berbeda-beda besar angkanya), 

maka pilih angka negatif dengan angka yang paling besar. 

 

 

 

               Tujuan 

    Sumber  
PT. Sun PT.Moon PT. Star KAPASITAS 

Pabrik Hope - 12 250 42 - 23 250 

Pabrik Believe 300 21 200 45 - 44 500 

Pabrik Imagine - 15 200 49 550 12 750 

KEBUTUHAN 300 650 550 1500 

C11 = 12–42+45–21 = -6 

C13 = 23–12+49–42 = 18 

C23 = 44–45+49–12 = 36 

C31 = 15–49+45–21 = -10 (minus terbesar) 
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2. Perubahan alokasi pengiriman. Dari pengujian di atas, didapat C31 

bernilai negatif (-10), maka pada sel C31 perlu dilakukan perubahan alokasi 

pengiriman. Perhatikan angka yang bertanda minus atau negatif saja! 

C31 = 0 + 

C32 = 200 - → NEGATIF dan ANGKA TERKECIL, maka 200 

dijadikan angka untuk mengurangi atau menambah alokasi yang ada 

selama pengujian 

C22 = 200 +  

C21 = 300 - 

Maka perubahan alokasinya:  

C31 = 0 + 200 = 200 

C32 = 200 - 200 = 0 

C22 = 200 + 200 = 400 

C21 = 300 - 200 = 100 

 

Masukkan hasil di atas ke dalam tabel! 

Tujuan 

Sumber PT. Sun PT. Moon PT. Star KAPASITAS 

Pabrik Hope - 12 250 42 - 23 250 

Pabrik Believe 100 21 400 45 - 44 500 

Pabrik Imagine 200 15 - 49 550 12 750 

KEBUTUHAN 300 650 550 1500 
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PERHATIKAN! 

Sebelum melanjut ke langkah berikutnya, lakukan pengecekan berikut! 

1. Apakah semua alokasi bila dijumlah ke bawah dan ke samping sudah sama 

dengan total kebutuhan dan kapasitas yang ada? 

2. Apakah jumlah sel terisi sudah memenuhi syarat yang ada (m+n)-1, m 

=  sumber dan n = tujuan, (3 + 3) - 1 = 5, jadi jumlah sel terisi adalah 5. 

3. Jika ya, tabel di atas sudah benar. Tapi apakah sudah OPTIMAL? 

Untuk mengetahui, mari kita lakukan pengecekan kembali ke sel-sel yang 

masih kosong seperti pada langkah 1. 

 

3. PENGUJIAN SEL KOSONG 

C11 =12–42+45–21   =-6 

C13 = 23 – 12 + 15–21+45–42 = 8 

C23 = 44 – 12 + 15– 21  = 26 

C32 = 49 – 45 + 21– 15  = 10 

 

PERHATIKAN! 

Bila dihasilkan angka negatif lebih dari satu sel (berbeda-beda besar angkanya), 

maka pilih angka negatif dengan angka yang paling besar. 

4. PERUBAHAN ALOKASI (C11) 

C11 = 0 + 100  = 100  C22 = 400 + 100 = 500 

C12 = 250 – 100  = 150  C21 = 100 – 100 = 0 
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Masukkan hasil di atas ke dalam tabel! 

Tujuan 

Sumber 
PT. Sun PT. Moon PT. Star KAPASITAS 

Pabrik Hope 100 12 150 42 - 23 250 

Pabrik Believe - 21 500 45 - 44 500 

Pabrik Imagine 200 15 - 49 550 12 7 

KEBUTUHAN 300 650 550 1500 

 

5. Apakah sudah OPTIMAL? Ulangi Langkah 1 untuk membuktikannya. 

PENGUJIAN SEL KOSONG 

C13=23–12+15─12 = 14 

C21=21–45+42–12 = 6 

C23=44–12+15–12+42–45 = 32 

C32=49–42+12–15 = 4 

PERHATIKAN!!! 

Dari hasil pengujian di atas, tidak ditemukan lagi hasil negatif, itu artinya, 

Tabel No.4 sudah benar dengan hasil total biaya yang paling minimal! 

Maka, total biaya optimalnya adalah 

(100 x 12) + (150 x 42) + (500 x 45) + (200 x 15) + (550 x 12) = 39.600 

 

3.2    Pembelajaran: MODI  

 

Metode MODI merupakan modifikasi dari metode Stepping Stone. Metode 

MODI menghitung indeks perbaikan untuk setiap sel kosong tanpa menggunakan 

jalur tertutup. Indeks perbaikan dihitung dengan terlebih dahulu menentukan nilai 

baris dan kolom. 
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Contoh soal 

PT. Dream memiliki 3 cabang pabrik dalam memenuhi permintaan produksinya. 

Dengan kapasitas masing-masing: 

Pabrik Kapasitas Produksi 

Hope 250 

Believe 500 

Imagine 750 

Jumlah 1500 

 

Saat ini ada 3 perusahaan yang meminta PT. Dream untuk memenuhi 

kebutuhannya, dengan besaran permintaan masing-masing: 

Perusahaan Kebutuhan 

PT Sun 300 

PT Moon 650 

PT Star 550 

Jumlah 1500 

 

Perkiraan biaya transportasi: 

Perusahaan 

Pabrik 
   PT Sun   PT Moon   PT Star 

Hope 12 42 23 

Believe 21 45 44 

Imagine 15 49 12 

 

Hasil perhitungan dengan metode VAM: 

Tujuan 

Sumber 
PT Sun PT Moon PT Star KAPASITAS 

Pabrik Hope - 12 250 42 - 23 250 

Pabrik Believe 300 21 200 45 - 44 500 

Pabrik Imagine - 15 200 49 550 12 750 

KEBUTUHAN 300 650 550 1500 
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Total biaya = (250x42)+(300x21)+(200x27)+(200x49)+(550x8)  

         = 42.200 

 

Dari hasil tersebut, kita akan memastikan biaya tersebut sudah paling minimal 

atau belum, dengan menggunakan transportasi solusi akhir. 

 

B. Metode MODI 

Langkah penyelesaian: 

1. Penggunaan metode MODI untuk solusi akhir dimulai dengan mencari lalu 

memberi nilai untuk setiap baris dan kolom yang ada. Pemberian nilai 

pertama kali diberikan untuk baris, dengan nilai 0 (nol). 

 

PERHATIKAN! 

1. Nilai diberikan pada baris yang pertama. 

2. Nilai diberikan kepada baris yang memiliki sel terisi alokasi paling banyak. 

 

Tujuan 

Sumber PT. Sun PT. Moon PT. Star KAPASITAS 

Pabrik Hope - 12 250 42 - 23 250 

Pabrik Believe 300 21 200 45 - 44 500 

Pabrik Imagine - 15 200 49 550 12 750 

KEBUTUHAN 300 650 550 1500 

Selanjutnya dilakukan pemberian nilai untuk baris dan kolom yang lain dengan 

cara memanfaatkan setiap sel yang telah teralokasi: 

Keterangan: B = baris, K = kolom 

 

 

 

 

 

Sel terisi Cbk = Bb + Kk = biaya pada sel 

0 
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C12=B1+K2=42→0+K2=42→K2=42  

C22=B2+K2=45→B2+42=45→B2=3  

C21=B2+K1=21→3+K1=21→K1=18 

 C32=B3+K2=49→B3+42=49→B3=7 

C33=B3+K3=12→7+K3=12→K3=5 

 

  18  42  5   

               Tujuan 

Sumber 
PT. Sun PT. Moon PT. Star KAPASITAS 

0 Pabrik Hope - 12 250 42 - 23 250 

3 Pabrik Believe 300 21 200 45 - 44 500 

7 Pabrik Imagine - 15 200 49 550 12 750 

 KEBUTUHAN 300 650 550 1500 

 

2. Melakukan perhitungan indeks perbaikan dengan menguji apakah sel yang 

masih kosong dalam tabel tersebut masih dapat memberikan penurunan 

biaya, dengan cara: 

 

Biaya pada sel kosong – nilai baris – nilai kolom 

Maksudnya, pengiriman ke sel C31 akan memberikan penurunan biaya 

transportasi paling besar 10. 

 

 

 

 

C11 = 12– 0 – 18  = -6 

C13 = 23 – 0 – 5  = 18 

C23 = 44 – 3 – 5  = 36 

   C31 = 15 – 7 – 18  = -10  → NILAI NEGATIF TERBESAR 
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3. Mengubah alokasi pengiriman ke sel C31 

Tujuan 

Sumber 
PT Sun PT Moon PT Star KAPASITAS 

Pabrik Hope - 12 250 42 - 23 250 

Pabrik Believe 300 21 200 45 - 44 500 

Pabrik Imagine - 15 200 49 550 12 750 

KEBUTUHAN 300 650 550 1500 

 

Perhatikan angka yang bertanda minus saja! 

C31 = 0 + 

C32 = 200 - → NEGATIF dengan ANGKA TERKECIL, maka 200 

dijadikan angka untuk mengurangi atau menambah alokasi yang ada 

pada tabel 

C22 = 200 +  

C21 = 300 - 

Maka perubahan alokasinya: 

C31 = 0 + 200 = 200 

C32 = 200 - 200 = 0 

C22 = 200 + 200 = 400 

C21 = 300 – 200 = 100 
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Masukkan hasil di atas ke dalam tabel! 

Tujuan 

Sumber 
PT Sun PT Moon PT Star KAPASITAS 

Pabrik Hope - 12 250 42 - 23 250 

Pabrik Believe 100 21 400 45 - 44 500 

Pabrik Imagine 200 15 - 49 550 12 750 

KEBUTUHAN 300 650 550 1500 

 

Lakukan pengecekan (m+n)-1, lalu sudahkah tabel tersebut optimal? 

Lakukan  pengecekan dengan mengulang kembali langkah 2. 

 

4. Sel Terisi 

 
C12 = B1+K2 = 42→0+K2 = 42 →K2 = 42  

C22 = B2+K2 = 45→B2+42 = 45→B2 = 3  

C21 = B2+K1 = 21→3+K1 = 21→K1 = 18  

C31 = B3+K1 = 15→ B3+18 = 15→ B3 = -3  

C33 = B3+K3 = 12 →-3+K3 = 12→ K3 = 15 

 

Tujuan 

Sumber 
PT Sun PT Moon PT Star KAPASITAS 

Pabrik Hope - 12 250 42 - 23 250 

Pabrik Believe 100 21 400 45 - 44 500 

Pabrik Imagine 200 15 - 49 550 12 750 

KEBUTUHAN 300 650 550 1500 

 

18 42 15 

0 

3 

-3 
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Sel Kosong 

C11 = 12 – 0 – 18 = -6 → nilai negatif, lakukan pengubahan alokasi 

pada sel C11 

C13 = 23 – 0 –15 = 8 

C23 = 44 – 3– 15 = 26 

C32 = 49 – (-3) – 42 = 10 

 

5. Mengubah alokasi pengiriman ke sel C11 

 

Tujuan 

Sumber 
PT Sun PT Moon PT Star KAPASITAS 

Pabrik Hope - 12 250 42 - 23 250 

Pabrik Believe 100 21 400 45 - 44 500 

Pabrik Imagine 200 15 - 49 550 12 750 

KEBUTUHAN 300 650 550 1500 

 

Perhatikan angka yang bertanda minus saja! 

C11 = 0 + 

C12 = 250 –  

C22 = 400 + 

C21 = 100 –  →  NEGATIF dengan ANGKA TERKECIL, maka 100 

dijadikan angka untuk mengurangi atau menambah alokasi yang pada 

tabel 

Maka perubahan alokasinya: 

C11 = 0 + 100 = 100  C22 = 400 + 100 = 500 

C12 = 250 – 100 = 150  C21 = 100 – 100 = 0 
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Masukkan hasil di atas ke dalam tabel! 

Tujuan 

Sumber 
PT Sun PT Moon PT Star KAPASITAS 

Pabrik Hope 100 12 150 42 - 23 250 

Pabrik Believe - 21 500 45 - 44 500 

Pabrik Imagine 200 15 - 49 550 12 750 

KEBUTUHAN 300 650 550 1500 

Lakukan pengecekan (m+n) -1, Sudahkah tabel tersebut optimal? Lakukan 

pengecekan dengan mengulang kembali langkah 2. 

 

6. Sel terisi  

C11=B1+K1=12→0+K1=12→K1=12 

C12=B1+K2=42→0+K2=42→K2=42 

C22=B2+K2=45→B2+42=45→B2=3 

C31=B3+K1=15→B3+12=15→B3=3 

C33=B3+K3=12→3+K3=12→K3=9 

  12         42       9  

 Tujuan 

 Sumber 
PT Sun PT Moon PT Star KAPASITAS 

0 Pabrik Hope 100 12 150 42 - 23 250 

3 Pabrik Believe - 21 500 45 - 44 500 

3 Pabrik Imagine 200 15 - 49 550 12 750 

 KEBUTUHAN 300 650 550 1500 
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Sel kosong 

 

C13 = 23 – 0 – 9 = 14 

 

C21 = 21 – 3 – 12 = 6 

 

C23 = 44 – 3 – 9 = 32 

 

C32 = 49 – 3 – 42 = 4 

 

  

Dari perhitungan sel kosong di atas, terlihat bahwa semua kemungkinan 

pemindahan alokasi pengiriman sudah positif sehingga dengan demikian tabel 

di atas telah OPTIMAL dan memiliki total biaya yang paling minimal. 

Total biaya = (100 x 12) + (150 x 42) + (500 x 45) + (200 x 15) + (550 x 12) 

  = 39.600 

 

Langkah-langkah pengerjaan menggunakan software WinQSB 

1.  Start → All Program  → WinQSB, buka Program Network Modeling  
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2. Untuk memulai pilih menu File → New Problem 

 

 

3. Pada form NET Problem Specification pilih  

• Problem Type = Transportation Problem  

• Objective Criterion = Minimization  

• Problem Title (isi data Anda)  

• Number of Sources = 3  

• Number of Destinations = 3 
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4. Ubah node names dari menu Edit → Node Names. Edit Node Names, klik 

OK untuk melanjutkan. 

 

 

5. Input sesuai dengan soal. 

 

 

6. Untuk melihat hasil akhir dari metode Transportasi Akhir pilih menu 
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7. Hasil akhir dengan menggunakan software Network Modeling WinQSB 
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Soal-Soal Uji Kemampuan 

1. PT. ULTRAMENTARI merupakan milik Andi yang memiliki 3 pabrik 

mobil yaitu pabrik Garuda, pabrik Rajawali, dan pabrik Elang yang nantinya 

akan memenuhi permintaan dari 3 daerah di Indonesia yaitu Bandung, 

Surabaya, dan Makassar. Andi telah menghitung biaya transportasi dengan 

menggunakan metode solusi awal VAM.  

Tujuan 

Sumber 
Bandung Surabaya Makassar Kapasitas 

Pabrik Garuda 150 10 - 35 - 22 150 

Pabrik Rajawali - 18 400 30 - 15 400 

Pabrik Elang 50 12 100 40 400 15 550 

KEBUTUHAN 200 500 400 1.100 

Dengan menggunakan metode solusi akhir stepping stone, berapakah biaya 

optimum yang dihasilkan? 

 

2. PT. NUSANTARA AIRWAYS memiliki 3 bandara hub yaitu Bandara 

Soekarno-Hatta, Bandara Juanda, dan Bandara Hasanuddin yang nantinya 

akan memenuhi permintaan penerbangan ke 3 kota tujuan yaitu Denpasar, 

Medan, dan Balikpapan. Rizal telah menghitung biaya transportasi dengan 

menggunakan metode solusi awal VAM. 

Tujuan 

Sumber 
Denpasar Medan Balikpapan Kapasitas 

Bandara 

Soekarno-Hatta 
- 14 - 28 100 16 100 

Bandara 

Juanda 
- 12 300 24 - 20 300 

Bandara 

Hasanuddin 
150 10 50 22 200 18 400 

Kebutuhan 150 350 300 800 

Dengan menggunakan metode solusi akhir stepping stone, berapakah biaya 

optimum yang dihasilkan?  
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3. Tuan Ahmad, seorang pengusaha logistik maritim, memiliki 3 pelabuhan 

utama yaitu Pelabuhan Tokyo, Pelabuhan Shanghai, dan Pelabuhan Sydney 

dengan kapasitas pengiriman masing-masing 120, 90, dan 60. Permintaan 

datang dari beberapa kota yaitu Los Angeles sebesar 60, Jeddah sebesar 130, 

dan Calgary sebesar 80. 

Tujuan 

Sumber 
Los Angeles Jeddah Calgary Kapasitas 

Pelabuhan 

Tokyo 
60 13 60 30 - 25 120 

Pelabuhan 

Shanghai 
- 20 70 35 20 28 90 

Pelabuhan 

Sydney 
- 17 - 40 60 22 60 

Kebutuhan 60 130 80 270 

 

Dengan menggunakan solusi awal metode VAM metode solusi akhir MODI, 

berapakah biaya optimum yang dihasilkan? 
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BAB IV 

PENUGASAN 
 

Deskripsi Modul 

Masalah penugasan berkaitan dengan sejumlah sumber daya manusia yang 

produktif untuk sejumlah tugas, yaitu antara assignment (tugas) dengan assignee 

(penerima tugas). Syarat yang harus dipenuhi adalah satu tugas untuk satu 

penerima tugas (one assignment for one assignee). Tujuannya adalah 

meminimumkan biaya, waktu ataupun untuk memaksimumkan keuntungan. 

 
Tujuan Modul 

Setelah menyelesaikan praktikum pada modul ini, praktikan akan memahami: 

1. Bagaimana cara mengatur pemberian tugas agar didapatkan hasil yang 

optimal. 

2. Bagaimana meminimumkan biaya dan memaksimumkan keuntungan dari 

pemberian tugas yang dilakukan. 

3. Apa saja hakikat dari suatu pengambilan keputusan. 

4. Tahapan apa saja yang harus dilalui dalam mengambil suatu keputusan 

agar dapat memberikan hasil yang efektif dan efisien.
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Isi 

Pembelajaran: penugasan minimalisasi tanpa Dummy 

 Latihan 1 Menghitung penugasan minimalisasi tanpa Dummy 

Pembelajaran: penugasan minimalisasi dengan Dummy 

 Latihan 2 Menghitung penugasan minimalisasi dengan Dummy 

Pembelajaran: penugasan maksimalisasi tanpa Dummy 

 Latihan 3 Menghitung penugasan maksimalisasi tanpa Dummy 

Pembelajaran: penugasan maksimalisasi dengan Dummy 

 Latihan 4 Menghitung penugasan maksimalisasi dengan Dummy 

Pembelajaran: Penggunaan Software POM QM 
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Syarat: satu tugas untuk satu penerima tugas (one assignment for one assignee). 

4.1 Penugasan 

Seperti masalah transportasi, masalah penugasan (assignment problem) 

merupakan suatu kasus dari masalah linear programming. Dalam dunia usaha 

(bisnis) dan industri, manajemen sering menghadapi masalah-masalah yang 

berhubungan dengan pemberian tugas untuk para karyawannya. Masalah 

penugasan berkaitan dengan sejumlah sumber daya manusia yang produktif 

untuk sejumlah tugas, yaitu antara assignment (tugas) dengan assignee 

(penerima tugas). 

 

 

 

4.2    Sejarah dan Penjelasan Singkat tentang Metode Penugasan 

Pertama kali dikembangkan oleh seorang ahli matematika berkebangsaan 

Hungaria bernama D. Konig pada tahun 1916. Metode assignment sering pula 

disebut sebagai metode Hungarian, syarat utama metode ini ialah berpasangan 

satu-satu sehingga dapat mencakup n! penugasan yang mungkin dilakukan. 

Masalah penugasan berkaitan dengan masalah minimalisasi (biaya, waktu) atau 

masalah maksimalisasi (keuntungan, volume penjualan, kemenangan). 

Apabila tugas lebih besar daripada penerima tugas maka harus ditambah 

Dummy pada penerima tugas dengan nilai sebesar “0”. Dan apabila tugas lebih 

kecil daripada penerima tugas maka harus ditambahkan Dummy pada tugas 

dengan nilai sebesar “0”. 

• Dummy ada untuk menyeimbangkan antara banyaknya tugas dengan  

banyaknya penerima tugas. 

• Apabila   penerima   tugas   mendapatkan   pekerjaan Dummy, berarti 

diasumsikan bahwa penerima tugas tersebut menganggur. 

• Apabila tugas tersebut diberikan kepada Dummy, diasumsikan 

pekerjaan itu tidak ada yang mengerjakan. 
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Minimalisasi 

Contoh Minimalisasi tanpa DUMMY 

 
MAMEN SCHOOL mengadakan studi lapangan untuk 6 Kelompok mahasiswa 

terpilih yang harus ditempatkan di perusahaan. Karena karakteristik perusahaan 

yang berbeda, menimbulkan biaya yang berbeda dari berbagai alternatif 

penugasan tersebut. Di bawah ini adalah biaya yang timbul dari perbedaan 

karakteristik tiap perusahaan. 

 PT A PT B PT C PT D 

Kelompok 1 18 12 32 10 

Kelompok 2 11 16 30 13 

Kelompok 3 27 25 19 33 

Kelompok 4 14 22 32 21 

Berdasarkan data tersebut, lakukan penugasan untuk tiap kelompok, agar biaya 

yang harus dikeluarkan menjadi optimal! 

Langkah Penyelesaian 

Step 1: Cari nilai terkecil untuk setiap baris. 

Step 2: Gunakan biaya terkecil tersebut untuk mengurangi semua biaya 

yang ada pada baris yang sama. 

 PT A PT B PT C PT D 

Kelompok 1 18–10=8 12–10=2 32–10=22 10–10=0 

Kelompok 2 11–11=0 16–11=5 30–11=19 13–11=2 

Kelompok 3 27–19=8 25–19=6 19–19=0 33–19=14 

Kelompok 4 14–14=0 22–14=8 32–14=18 21–14=7 

 
Step 3: Pastikan semua baris dan kolom SUDAH memiliki nilai NOL. Jika ada 

yang belum memiliki nilai nol (kolom 2), maka cari nilai terkecil di kolom 

tersebut digunakan untuk mengurangi semua nilai yang ada di kolom tersebut. 
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*sehingga menjadi* 
 

 PT A PT B PT C PT D 

Kelompok 1 18–10=8 12–12=0 32–10=22 10–10=0 

Kelompok 2 11–11=0 16–12=4 30–11=19 13–11=2 

Kelompok 3 27–19=8 25–12=13 19–19=0 33–19=14 

Kelompok 4 14–14=0 22–12=10 32–14=18 21–14=7 

 
Step 4: Jika tiap kolom dan baris sudah memiliki nilai nol. Maka cek, apakah 

ditemukan nilai nol sebanyak sumber daya (banyak baris) dan sebanyak pekerjaan 

(kolom). Misal: Jika jumlah baris 3 kolom 3, maka jumlah nilai nol minimal harus 

ada 3. 

Step 5: Jika sudah menemukan nilai nol sejumlah baris dan kolom. Maka tandai 

dengan melakukan coretan. 

PERHATIKAN! 

 

Walau nilai nol sudah memenuhi syarat. Namun pada kolom 1 terdapat 2 nilai 0 

walaupun terdapat pada baris yang berbeda. Maka dapat dipastikan belum 

optimal. 

Step 6: Karena belum optimal, maka tarik garis yang menghubungkan setiap nilai 

nol. 

 PT A PT B PT C PT D 

Kelompok 1 8 0 22 0 

Kelompok 2 0 4 19 2 

Kelompok 3 8 13 0 14 

Kelompok 4 0 10 18 7 
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Step 7: Perhatikan nilai yang TIDAK TERKENA GARIS. Cari nilai yang terkecil. 

Lalu gunakan untuk menambah atau mengurang nilai lainnya, dengan ketentuan 

berikut: 

• Mengurangi Nilai Yang Tidak Kena Coret 

• Menambah Nilai Yang Kena Coret 2x 

• Untuk Nilai Yang Kena Coret 1x, Nilainya Tetap 

 

 PT A PT B PT C PT D 

Kelompok 1 10 0 22 0 

Kelompok 2 0 2 17 0 

Kelompok 3 10 13 0 14 

Kelompok 4 0 8 16 5 

 
Step 8: Setelah menemukan perusahaan yang paling tepat untuk tiap kelompok. 

Langkah selanjutnya, cari biaya penugasannya. 

 

Penugasan Optimum: 
 

Kelompok 1 : PT B = 12 

Kelompok 2 : PT D = 13 

Kelompok 3 : PT C = 19 

Kelompok 4 : PT A = 14 + 

Total biaya  = 58 

 
Analisis: 

Kelompok 1 ditugaskan ke PT B dengan biaya 12, Kelompok 2 ditugaskan ke PT 

D dengan biaya 13, Kelompok 3 ditugaskan ke PT C dengan biaya 19, Kelompok 

4 ditugaskan ke PT A dengan biaya 14, dan Total biaya yang dikeluarkan sebesar 

58.
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Contoh Minimalisasi dengan DUMMY 

Langkah penyelesaian sama seperti kasus minimalisasi tanpa Dummy. Namun, 

jika kasus dengan Dummy, berarti yang dianggap sebagai BIAYA TERKECIL 

adalah Dummy. 

Contoh soal:  

Perkebunan Mekar memiliki 4 petani baru yang akan ditugaskan untuk menanam 

satu jenis tanaman saja. Berikut biaya yang mungkin muncul. 

 

Tanaman 

Nama 
Padi Singkong Ubi 

Petani M 44 39 22 

Petani N 34 19 22 

Petani O 41 48 21 

Petani P 12 26 15 

 
Berdasarkan data biaya tersebut maka tentukanlah tanaman untuk masing-masing 

petani! Berikan analisisnya. 

 
Langkah Penyelesaian 
 

Step 1: Cari nilai terkecil untuk setiap baris karena ada Dummy jadi nilai 

terkecil adalah Dummy. 

Step 2: Pastikan semua baris dan kolom SUDAH memiliki nilai NOL. Jika ada 

yang belum memiliki nilai nol, maka cari nilai terkecil di kolom tersebut 

digunakan untuk mengurangi semua nilai yang ada di kolom tersebut. 

Jarak 

Nama 
Padi Singkong Ubi Dummy 

Petani M 44–0=44 39–0=39 22–0=22 0-0=0 

Petani N 34–0=34 19–0=19 22–0=22 0-0=0 

Petani O 41–0=41 48–0=48 21–0=21 0-0=0 

Petani P 12–0=12 26–0=26 15–0=15 0-0=0 
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*Lalu menjadi 

 

Jarak  

Nama 

 

Padi 

 

Singkong 

 

Ubi 

 

Dummy 

Petani M 44–12=32 39–19=20 22–15=7 0 

Petani N 34–12=22 19–19=0 22–15=7 0 

Petani O 41–12=29 48–19=29 21–15=6 0 

Petani P 12–12=0 26–19=7 15–15=0 0 

Step 3: Jika tiap kolom dan baris sudah memiliki nilai nol. Maka cek, apakah 

ditemukan nilai nol sebanyak sumber daya (banyak baris) dan sebanyak pekerjaan 

(kolom). Misal: Jika jumlah baris 4 kolom 4, maka jumlah nilai nol minimal harus 

ada 4. 

Step 4: Jika sudah menemukan nilai nol sejumlah baris dan kolom. Maka tandai 

dengan melakukan coretan
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PERHATIKAN! 

 
Walau nilai nol sudah memenuhi syarat. Namun pada kolom 4 terdapat 4  nilai 0 

walaupun pada baris yang berbeda. Maka dapat dipastikan belum optimal. 

Step 5: Karena belum optimal, maka tarik garis yang menghubungkan setiap nilai 

nol, lakukan dengan menghubungkan nilai 0 lebih dari satu terlebih dahulu. 

Jarak 

Nama 
Padi Singkong Ubi Dummy 

Petani M 32 20 7 0 

Petani N 
22 0 7 0 

Petani O 29 29 6 0 

Petani P 0 7 0 0 

 

Step 6: Perhatikan nilai yang TIDAK TERKENA GARIS. Cari nilai yang 

terkecil. Lalu gunakan untuk menambah atau mengurangi nilai lainnya, dengan 

ketentuan berikut: 

• Untuk Mengurangi Nilai Yang Tidak Kena Coret 

• Untuk Menambah Nilai Yang Kena Coret 2x 

• Dan Untuk Nilai Yang Kena Coret 1x, Nilainya Tetap 

 
*sehingga menjadi 
 

Jarak 

Nama 

Padi Singkong Ubi Dummy 

Petani M 26 14 1 0 

Petani N 22 0 7 6 

Petani O 23 23 0 0 

Petani P 0 7 0 6 
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Step 7: Setelah menemukan tugas yang paling tepat untuk tiap tanaman. Langkah 

selanjutnya, cari biaya penugasannya. 

 

Penugasan optimum: 
 

Petani M : Dummy = 0 

Petani N : Singkong = 19 

Petani O : Ubi = 21 

Petani P : Padi = 12 +         

    52 

 

Analisis: 

Untuk mendapatkan biaya paling minimum, Perkebunan Mekar harus 

menugaskan Petani M menanam Dummy dengan biaya 0, Petani N menanam 

Singkong dengan biaya 19, Petani O menanam Ubi dengan biaya 21, dan Petani P 

menanam Padi dengan biaya 12. Sehingga didapat biaya paling minimal sebesar 

52. 
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Maksimalisasi 

Contoh Maksimalisasi tanpa DUMMY 

 
Berdikari Service mengharuskan spesialisasi untuk setiap karyawan. Masing- 

masing karyawan akan dipilih untuk mengerjakan satu pekerjaan saja sesuai 

dengan keterampilan yang dapat memberikan keuntungan paling optimal. 
 

 TV AC Kulkas Dispenser Kipas 

Ari 12 20 18 21 18 

Ira 16 28 44 28 32 

Ria 28 33 24 34 21 

Arra 37 23 21 32 30 

Aan 19 16 47 22 27 

 

Langkah Penyelesaian 
 

Step 1: Cari nilai terbesar di setiap baris 

 

Step 2: Gunakan nilai terbesar sebagai pengurang nilai yang ada pada baris yang 

sama. 

 TV AC Kulkas Dispenser Kipas 

Ari 21–12=9 21–20=1 21–18=3 21–21=0 21–18=3 

Ira 44–16=28 44–28=16 44–44=0 44–28=16 44–32=12 

Ria 34–28=6 34–33=1 34–24=10 34–34=0 34–21=13 

Arra 37–37=0 37–23=14 37–21=16 37–32=5 37–30=7 

Aan 47–19=28 47–16=31 47–47=0 47–22=25 47–27=20 
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Step 3: Pastikan semua baris dan kolom SUDAH memiliki nilai NOL. Jika ada 

yang belum memiliki nilai nol (kolom 2 dan 5), maka cari nilai terkecil di kolom 

tersebut digunakan untuk mengurangi semua nilai yang ada di kolom tersebut. 

 TV AC Kulkas Dispenser Kipas 

Ari 9 1 – 1=0 3 0 3 –3=0 

Ira 28 16 – 1=15 0 16 12–3=9 

Ria 6 1 – 1=0 10 0 13 –3=10 

Arra 0 14 – 1=13 16 5 7 –3=4 

Aan 28 31 – 1=30 0 25 20 –3=17 

 

Step 4: Jika tiap kolom dan baris sudah memiliki nilai nol. Lalu cek, apakah 

ditemukan nilai nol sebanyak sumber daya (banyak baris) dan sebanyak pekerjaan 

(kolom). Misal: Jika jumlah baris 5 kolom 5, maka jumlah nilai nol minimal harus 

ada 5. 

Step 5: Jika sudah menemukan nilai nol sejumlah baris dan kolom. Maka tandai 

dengan melakukan coretan 

PERHATIKAN!  

Walau nilai nol sudah memenuhi syarat. Namun pada kolom 2, 3 dan 4 terdapat 2 

nilai 0 walaupun terdapat pada baris yang berbeda. Maka dapat dipastikan belum 

optimal. 

Step 6: Karena belum optimal, maka tarik garis yang menghubungkan setiap nilai 

nol. 

 TV AC Kulkas Dispenser Kipas 

Ari 9 0 3 0 0 

Ira 28 15 0 16 9 

Ria 6 0 10 0 10 

Arra 0 13 16 5 4 

Aan 28 30 0 25 17 



 

72 Riset Operasional 1 

 

Step 7: Perhatikan nilai yang TIDAK TERKENA GARIS. Cari nilai yang terkecil. 

Lalu gunakan untuk menambah atau mengurangi nilai lainnya, dengan ketentuan 

berikut: 

• Untuk Mengurangi Nilai Yang Tidak Kena Coret 

• Untuk Menambah Nilai Yang Kena Coret 2x 

• Dan Untuk Nilai Yang Kena Coret 1x, Nilainya Tetap 

 

*Sehingga menjadi 

 

 TV AC Kulkas Dispenser Kipas 

Ari 9 0 12 0 0 

Ira 19 6 0 7 0 

Ria 6 0 19 0 10 

Arra 0 13 25 5 4 

Aan 19 21 0 16 8 

 
Step 8: Setelah menemukan tugas yang paling tepat untuk tiap karyawan. Langkah 

selanjutnya, cari hasil produksinya. 

Ari : Dispenser = 21 

Ira : Kipas = 32 

Ria : AC = 33 

Arra : TV = 37 

Aan : Kulkas = 47 + 

Total Keuntungan = 170 

Analisis: 

Untuk mendapatkan keuntungan maksimum, Ari ditugaskan men-service 

Dispenser dengan keuntungan 21, Ira men-service Kipas dengan keuntungan 32, 

Ria men-service AC dengan keuntungan 33, Arra men-service TV dengan 

keuntungan 37 dan Aan men-service Kulkas dengan keuntungan 47. Jadi total 

keuntungan maksimum yang akan diperoleh adalah 170. 
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Contoh Maksimalisasi dengan DUMMY 

Les BIMBU menugaskan karyawannya untuk mengajar anak dengan tingkatan 

kelas. Berikut merupakan data keuntungan dari keterampilan pengajar les bimbu 

menghadapi banyaknya anak. 

 KELAS 3 KELAS 4 KELAS 5 

RESA 55 24 23 

SANTI 23 42 18 

LELIENI 34 33 21 

CITRA 12 20 12 

Tentukan penugasan optimumnya agar keuntungan “LES BIMBU” maksimum, 

sertakan analisisnya! 

 

Langkah Penyelesaian 
 

Step 1: Cari nilai terbesar di setiap baris. 

 

Step 2: Gunakan nilai terbesar sebagai pengurang nilai yang ada pada baris yang 

sama. 
 

 KELAS 3 KELAS 4 KELAS 5 DUMMY 

RESA 55–55=0 55–24=31 55–23=32 55–0=55 

SANTI 42–23=19 42–42=0 42–18=24 42–0=42 

LELIENI 34–34=0 34–33=1 34–21=13 34–0=34 

CITRA 20–12=8 20–20=0 20–12=8 20–0=20 
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Step 3: Pastikan semua baris dan kolom SUDAH memiliki nilai NOL. Jika ada 

yang belum memiliki nilai nol (kolom 3 dan 4), maka cari nilai terkecil di kolom 

tersebut digunakan untuk mengurangi semua nilai yang ada di kolom tersebut. 

 KELAS 3 KELAS 4 KELAS 5 DUMMY 

RESA 0 31 32 – 8 = 24 55–20=35 

SANTI 19 0 24–8= 16 42–20=22 

LELIENI 0 1 13–8=5 34–20=14 

CITRA 8 0 8 – 8 = 0 20–20=0 

 
Step 4: Jika tiap kolom dan baris sudah memiliki nilai nol. Lalu cek, apakah 

ditemukan nilai nol sebanyak sumber daya (banyak baris) dan sebanyak pekerjaan 

(kolom). Misal: Jika jumlah baris 4 kolom 4, maka jumlah nilai nol minimal harus 

ada 4. 

Step 5: Jika sudah menemukan nilai nol sejumlah baris dan kolom. Maka tandai 

dengan melakukan coretan. 

PERHATIKAN!  

Walau nilai nol sudah memenuhi syarat. Namun pada kolom 1 dan 2 terdapat 2 

nilai 0 walaupun terdapat pada baris yang berbeda. Maka dapat dipastikan belum 

optimal. 

Step 6: Karena belum optimal, maka tarik garis yang menghubungkan setiap nilai 

nol. 

 KELAS 3 KELAS 4 KELAS 5 DUMMY 

RESA 0 31 24 35 

SANTI 19 0 16 22 

LELIENI 0 1 5 14 

CITRA 8 0 0 0 
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Step 7: Perhatikan nilai yang TIDAK TERKENA GARIS. Cari nilai yang 

terkecil. Lalu gunakan untuk menambah atau mengurangi nilai lainnya, dengan 

ketentuan berikut: 

• Untuk Mengurangi Nilai Yang Tidak Kena Coret 

• Untuk Menambah Nilai Yang Kena Coret 2x 

• Dan Untuk Nilai Yang Kena Coret 1x, Nilainya Tetap 

 

*sehingga menjadi 

 KELAS 3 KELAS 4 KELAS 5 DUMMY 

RESA 0 31 19 30 

SANTI 19 0 11 17 

LELIENI 0 1 0 9 

CITRA 13 5 0 0 

 

Step 8: Setelah menemukan tugas yang paling tepat untuk tiap karyawan. Langkah 

selanjutnya, cari keuntungannya. 

Penugasan optimum: 

Resa : Kelas 3 = 55 

Santi : Kelas 4 = 42 

Lelieni : Kelas 5 = 21 

Citra : Dummy =  0  + 

Total Keuntungan = 118 

 

Analisis: 

Resa mengajar Kelas 3 dengan keuntungan 55, Santi mengajar Kelas 4 dengan 

keuntungan 42, Lelieni mengajar Kelas 5 dengan keuntungan 21, Citra mengajar 

Dummy tanpa keuntungan. Sehingga total keuntungan yang didapat sebesar 118.
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Langkah-langkah pengerjaan menggunakan software POM-QM 

 
• Start → Search Program → POM-QM. Kemudian klik. 

 

 

• Di menu bar Module → Assignment. Lalu, klik. 
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• Pilih menu File → Klik New 

 

 

• Input jumlah baris (Jobs) dan kolom (Machines) sesuai dengan soal. 

 

• Input data sesuai dengan soal. 
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• Klik Solve 
 

 

 

 

• Hasil perhitungan aplikasi, Resa menempati Kelas 3 dengan keuntungan 55, 

Santi menempati Kelas 4 dengan keuntungan 42, Lelieni menempati Kelas 5 

dengan keuntungan 21, dan Citra menempati Dummy dengan keuntungan 0. 

Sehingga total keuntungan yang diperoleh sebesar 118.       
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Soal-Soal Uji Kemampuan 

 
1. Perusahaan Sebuah restoran memiliki 4 koki dan 4 jenis masakan. Setiap koki 

memiliki tingkat keahlian yang berbeda untuk setiap jenis masakan. Biaya 

yang diperlukan untuk menyiapkan setiap masakan oleh masing-masing koki 

disajikan dalam tabel berikut: 

 Sup Salad Main 

Course 

Dessert 

Chef A 15 10 30 20 

Chef B 12 15 25 18 

Chef C 18 12 28 22 

Chef D 14 11 32 25 

 

Berdasarkan data tersebut, lakukan penugasan untuk tiap jenis masakan, agar 

keuntungan yang harus dikeluarkan menjadi optimal, Sertakan analisisnya! 

 

 

2. Sebuah perusahaan logistik memiliki 4 kurir dan 3 rute pengiriman. Setiap 

kurir akan ditugaskan ke berbagai rute dan memiliki estimasi jumlah paket 

yang dapat diantar per hari di setiap rute. Estimasi jumlah paket yang dapat 

diantar dari setiap kombinasi kurir dan rute diberikan dalam tabel berikut: 

 Jakarta Bali Bandung 

A 50 40 30 

B 45 50 35 

C 55 35 25 

D 40 45 40 

 

Tentukan penugasan di berbagai kota agar mendapatkan biaya paling 

minimum, sertakan analisisnya! 
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3. Sebuah perusahaan teknologi memiliki 4 tim pengembang dan 4 proyek 

software. Setiap tim memiliki tingkat produktivitas yang berbeda untuk setiap 

jenis proyek. Biaya yang diperlukan untuk menyelesaikan setiap proyek oleh 

masing-masing tim disajikan dalam tabel berikut: 

 

 Web App Mobile App Al System Cloud Service 

Alpha 50 45 55 60 

Beta 40 35 30 45 

Gamma 25 30 35 20 

Delta 35 40 30 25 

 

Berdasarkan data tersebut, setiap tim melakukan penugasan untuk tiap proyek, 

agar mendapatkan biaya paling minimum dan berikan juga analisisnya! 
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BAB V 

TEORI PERMAINAN 

 

Deskripsi Modul 

Teori permainan (game theory) adalah suatu pendekatan matematis untuk 

merumuskan situasi persaingan dan konflik antar berbagai kepentingan. Teori ini 

dikembangkan untuk menganalisa proses pengambilan keputusan dari situasi 

persaingan yang berbeda-beda dan melibatkan dua atau lebih kepentingan. 

 

Tujuan Modul 

Setelah menyelesaikan praktikum pada modul ini, praktikan akan: 

1. Mengetahui apa itu teori permainan. 

2. Mengetahui unsur-unsur dalam membentuk teori permainan. 

3. Mengetahui jenis-jenis strategi dalam teori permainan. 

4. Dapat menganalisis strategi terbaik dengan menggunakan teori permainan. 

Isi 

Pembelajaran: Game Theory 

Latihan 1 Menghitung Teori Permainan  

Pembelajaran: Penggunaan Software POM QM 
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5.1  Pengantar: Teori Permainan 

Teori permainan adalah suatu pendekatan matematis untuk merumuskan 

situasi persaingan dan konflik antar berbagai persaingan. Teori ini dikembangkan 

untuk menganalisa proses pengambilan keputusan dari situasi persaingan yang 

berbeda dan melibatkan dua atau lebih kepentingan. Kepentingan-kepentingan 

yang bersaing dalam permainan disebut pemain (players). Anggapan yang 

digunakan adalah bahwa setiap pemain mempunyai kemampuan untuk mengambil 

keputusan secara bebas dan rasional. 

Teori permainan mula-mula dikemukakan oleh seorang ahli matematika 

Perancis yang bernama Emile Borel pada tahun 1921. Kemudian, John Von 

Neumann dan Oskar Morgenstern mengembangkan lebih lanjut sebagai alat untuk 

merumuskan perilaku ekonomi yang bersaing. 

Model teori permainan dapat diklasifikasikan dengan sejumlah cara seperti 

jumlah pemain, jumlah keuntungan dan kerugian serta jumlah strategi yang 

digunakan dalam permainan. Sebagai contoh, bila jumlah pemain adalah dua, 

permainan disebut sebagai permainan dua-pemain. Begitu juga, bila jumlah 

pemain adalah N (dengan N>3), ini disebut permainan N-pemain. 

Jika jumlah keuntungan dan kerugian adalah nol, disebut permainan jumlah- 

nol atau jumlah-konstan. Sebaliknya bila tidak sama dengan nol, permainan 

disebut permainan bukan jumlah nol (non zero-sum game). 

5.2  Unsur-Unsur Dalam Membentuk Teori Permainan 

Untuk pembahasan teori ini digunakan contoh permainan dua pemain jumlah nol. 

 

Pemain A 

Pemain B 

B1 B2 B3 

A1 6 4 8 

A2 7 3 1 

Tabel 4.1 Matriks permainan dua pemain jumlah nol 
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Dari tabel diatas, beberapa unsur dasar permainan ini adalah: 

1. Angka-angka dalam matriks pay off (matriks permainan) menunjukkan hasil 

dari strategi permainan yang berbeda. Dalam permainan dua pemain jumlah 

nol ini, bilangan positif menunjukkan keuntungan bagi pemain baris dan 

merupakan kerugian dari pemain kolom. 

2. Anggapan yang digunakan adalah bahwa suatu strategi tidak dapat dirusak 

oleh pesaing atau faktor lain. 

3. Suatu strategi dikatakan dominan bila setiap pay off dalam strategi adalah 

superior terhadap setiap pay off yang berhubungan dalam suatu strategi 

alternatif. Contoh dalam permainan diatas untuk pemain A, strategi permainan 

A1 didominasi oleh strategi A2. 

4. Suatu strategi optimal adalah rangkaian kegiatan atau rencana yang 

menyeluruh yang menyebabkan seorang pemain dalam posisi yang paling 

menguntungkan tanpa memperhatikan kegiatan-kegiatan pesaingnya. 

5. Tujuan model permainan adalah mengidentifikasikan strategi atau rencana 

optimal untuk setiap pemain. 

 

5.3 Jenis Strategi Dalam Teori Permainan 

1. Permainan Strategi Murni (PURE-STRATEGY GAME) 

Dalam permainan strategi murni, strategi optimal untuk setiap pemain 

adalah dengan menggunakan strategi tunggal. Pemain baris mengidentifikasikan 

strategi optimalnya melalui aplikasi kriteria maksimin (maximin) dan pemain 

kolom dengan kriteria minimaks (minimax). Nilai yang dicapai harus merupakan 

maksimum dari minimaks baris dan minimum dari maksimin kolom titik ini 

dikenal sebagai titik pelana (saddle point). 

Bila nilai minimaks tidak sama dengan nilai maksimin, maka permainan 

tidak dapat dipecahkan dengan strategi murni harus menggunakan strategi 

campuran. 
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Langkah-langkah penyelesaian: 

1. Carilah nilai minimum baris dan maksimum kolom. 

2. Dari nilai-nilai minimum setiap baris cari nilai maksimalnya atau disebut 

nilai maksimin. Sedangkan dari nilai maksimum kolom tentukan satu nilai 

minimal sebagai nilai minimaks. 

3. Bila nilai minimaks sama dengan nilai maksimin, berarti strategi yang 

paling optimal untuk masing-masing pemain telah ditemukan. 

Pemain A 
Pemain B 

Minimum Baris 
B1 B2 B3 

A1 6 4 8 4*(Maks) 

A2 7 3 1 1 

Maksimum 

Kolom 7 4*(Min) 8 
 

Tabel 4.2 Permainan Strategi Murni 

 

Dari hasil tabel diatas, nilai maksimin dan minimaks sama sehingga strategi yang 

optimal untuk A adalah strategi A1 (baris dmana terdapat nilai maksimin) dan 

untuk B adalah strategi B2 (strategi dimana terdapat nilai minimaks). 

 

2. Permainan Strategi Campuran (MIXED-STRATEGY GAME) 

Seperti yang dikatakan sebelumnya bahwa bila nilai maksimin dan 

minimaks tidak sama. Penyelesaian soal adalah dengan strategi campuran. 

Untuk memperjelas penjelasan strategi ini digunakan contoh berikut: 
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Pemain A 

Pemain B Jumlah Minimum 

Baris B1 B2 B3 

A1 2 9 8 19 *(Maks) 

A2 1 4 6 11 

A3 7 3 5 15 

Jumlah 

Maksimum 

Kolom 
10*(Min) 16 19 

 

Tabel 4.3 Permainan Strategi Campuran (1) 

Dari tabel diatas, diketahui bahwa nilai maksimin tidak sama dengan nilai 

minimaks. Dengan menerapkan aturan dominan maka strategi B3 didominasi 

oleh strategi B1 sehingga kolom B3 dihapuskan. Demikian juga strategi A2 

didominasi oleh strategi A1 sehingga baris A2 dihilangkan. Matriks permainan 

berubah menjadi seperti berikut: 

 

Pemain A 
Pemain B 

Jumlah Minimum 

Baris B1 B2 

A1 2 9 11 

A3 7 3 10 

Jumlah Maksimum 

Kolom 9 12  

Tabel 4.4 Permainan Strategi Campuran (2) 

Karena nilai maksimin tetap tidak sama dengan nilai minimaks, maka 

penyelesaian permainan strategi ini dapat dilakukan dengan menggunakan 

metode grafik, metode aljabar matriks, metode analitis atau linear 

programming. Dibawah ini hanya akan dijelaskan mengenai metode analitis. 
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a. Metode Analitis 

Dalam pola ini, kita menentukan suatu distribusi probabilitas untuk strategi-

strategi yang berbeda. Nilai-nilai probabilitas pay off dapat dihitung dengan 

cara berikut. 

➢ Untuk pemain A 

Anggap bahwa digunakan strategi A1 dengan probabilitas P dan untuk 

strategi A3 probabilitasnya 1-p. 

- Jika strategi yang digunakan oleh B adalah B1, maka keuntungan yang 

diharapkan A adalah: 2p + 7(1 - p) = 7 - 5p 

- Bila B menggunakan strategi B2, maka keuntungan yang diharapkan A 

adalah: 9p + 3(1 - p) = 3 + 6p 

 

Strategi optimal untuk A diperoleh dengan menyamakan kedua pay off yang 

diharapkan, sehingga diperoleh: 

7 - 5p = 3 + 6p 

   p = 4/11 atau 0,36 

Ini berarti pemain A (dengan hasil pembulatan) harus menggunakan strategi 

A1 36% dan strategi A3 64%. Keuntungan yang diharapkan pemain A : 

= 2 (4/11) + 7 (7/11) 

= 9 (4/11) + 3 (7/11) 

= 57/11 atau 5,18 
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➢ Untuk pemain B 

Dengan cara yang sama dapat dihitung pay off yang diharapkan untuk 

pemain B. Probabilitas untuk strategi B1 adalah q dan B2 adalah 1 - q. 

Maka: 

- Kerugian B, jika A menggunakan strategi A1 adalah :  

2q + 9 (1 - q) = 9 - 7q 

- Kerugian B, jika A menggunakan strategi A3 adalah :  

7q + 3 (1 - q) = 3 + 4q 

 

Strategi optimal untuk pemain B adalah : 

9 - 7q = 3 + 4q 

q = 6/11 atau 0,55 

Hasil ini berarti pemain B (dengan hasil pembulatan) seharusnya 

menggunakan strategi B1 55% dan strategi B2 menggunakan 45%. 

Kerugian yang diharapkan untuk pemain B: 

= 2 (6/11) + 9 (5/11) 

= 7 (6/11) + 3 (5/11) 

= 57/11 atau 5,18 
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Langkah-langkah pengerjaan menggunakan software POM-QM 

1. Start → Search Program → POM-QM. Kemudian klik. 

 

 

2. Di menu bar Module → Game Theory. Lalu, klik. 
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3. Pilih menu File → Klik New 

 

 

4. Input jumlah baris (Row) dan kolom (Column) sesuai dengan soal. 

 

 

5. Input data sesuai dengan soal 
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6. Klik Solve 

 

 

7. Hasil perhitungan dengan software, 5,18 dengan A1 sebesar 36% dan A3 

sebesar 64%. Juga B1 sebesar 55% dan B2 sebesar 45%. 
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Soal-Soal Uji Kemampuan 

1. Dua perusahaan yang bergerak di bidang industri makanan cepat saji sedang 

terlibat persaingan dagang dalam menjual produk makanan mereka masing-

masing. Kedua perusahaan tersebut memiliki strategi untuk bisa 

memenangkan persaingan dan pasar pesaing. Berikut strategi yang digunakan 

kedua perusahaan tersebut. 

 

Strategi mana yang akan dipilih kedua perusahaan tersebut dan berapa 

kemenangan yang didapat? 

 

 

2. Dua perusahaan yang bergerak di bidang fashion sedang terlibat persaingan 

dagang dalam menjual produk fashion mereka masing-masing. Kedua 

perusahaan tersebut memiliki strategi untuk bisa memenangkan persaingan 

dan pasar pesaing. Berikut strategi yang digunakan kedua perusahaan 

tersebut. 

 

ERIGO 

EIGER 

B1 B2 B3 

A1 6 1 9 

A2 2 5 6 

A3 5 8 4 

 

Strategi mana yang akan dipilih kedua perusahaan tersebut dan berapa 

kemenangan yang didapat? 

 

 

 

MCD 

 

KFC 

B1 B2 B3 

A1 6 9 3 

A2 5 1 8 

A3 5 4 2 
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3. Dua perusahaan yang bergerak di bidang kosmetik sedang terlibat persaingan 

dagang dalam menjual produk kosmetik mereka masing-masing. Kedua 

perusahaan tersebut memiliki strategi untuk bisa memenangkan persaingan 

dan pasar pesaing. Berikut strategi yang digunakan kedua perusahaan 

tersebut. 

MADAM GIE AVOSKIN 

B1 B2 B3 

A1 7 5 8 

A2 5 4 3 

A3 8 9 2 

 

Strategi mana yang akan dipilih kedua perusahaan tersebut dan berapa 

kemenangan yang didapat? 
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